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Chapter

Db2 Web Query Administration Console

The Db2 Web Query Administration Console enables you to remotely manage your Db2
Web Query environment. Using the Console, administrators can navigate through and
change various configuration settings for the Db2 Web Query Client.

In this chapter:
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Accessing the Db2 Web Query Administration Console
Configuring Db2 Web Query
Changing Web Query Client Settings in Web Query

Working With HTML5 Chart Extensions
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Accessing the Db2 Web Query Administration Console

Accessing the Db2 Web Query Administration Console

To access the Administration Console, on the Hub:

. In the side navigation pane, select Management Center and then, under Client

Administration, select Administration Console, as shown in the following image.
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The Db2 Web Query Administration Console opens.
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Configuring Db2 Web Query

To use the Db2 Web Query Administration Console to update Db2 Web Query Client
configuration settings, click the Configuration tab and select one of the categories in the menu,
as shown in the following image.
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You can also click any of the following options located on the right side, along the top of the
screen:

Clear Cache. Clears your memory cache, which contains information that gets processed with
every Db2 Web Query Servlet request. This includes Db2 Web Query script and configuration
files, and the default Managed Reporting Driver cache.

By clearing the cache, it fully revokes the Report Broker scheduling privileges from a user. This
should be done after a user is moved into or removed from a folder-sched group.

Help. Opens the online help file.

Application Settings

Application Settings determine the configuration and behavior of the Db2 Web Query web
application.
Procedure: How to View or Edit Application Settings

1. In the Administration Console, on the Configuration tab, expand the Application Settings
folder and click the node of the category of settings you would like to view or edit.

The settings appear in the main configuration pane.

2. Make the desired changes and click Save.
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Reference:

Application Caches Settings

Settings on the Application Caches page configure the size and contents of the Data Values
Cache on the Application Server. This cache contains values assigned to parameters used in
Autoprompt Reports, Embedded Bl Applications, or any procedure that includes the FIND
parameter syntax to limit the range of available search parameter values.

These settings establish the default configuration for Data Values Cache operations in your
environment. Administrators and users who have the privilege to work with the Session Viewer
can temporarily override these default settings using options in the Caching list.

The Application Caches page also includes the Report Output Cache setting that establishes
the use of a separate cache for report output.

Data Values Max Cache Memory (MB)

Defines the maximum amount of memory allocated to the Data Values Cache. This cache
holds the data source values retrieved from queries to the Server issued by procedures
that identify their Master File sources with a two-part name in the FIND parameter syntax.
These values are typically assigned to parameters used in Autoprompt Reports, Embedded
Bl Applications, or to any procedure that includes the FIND parameter syntax to limit the
range of available search parameter values. This cache also contains the IBFS path to the
Master File and the ID of the user that ran the procedure. The Data Values Cache uses
memory on the machine that hosts the Web Query Application Server.

This setting is assigned a value of zero (0), by default, meaning that no memory is
allocated to the data values cache, and no data values are cached.

To activate the use of the data values cache, an administrator must assign a number from
one (1) to five hundred (500) to this setting. A value of ten (10) megabytes can
accommodate the caching requirements for most organizations.

Data Values User Cache Paths

Identifies the IBFS Paths to those resources whose data source values should only be
made available to the individual user who retrieved the data.

The paths defined in this setting should only identify resources that contain data that is
subject to DBA or row-level security restrictions. For calls to cache resources that are not
subject to these restrictions, Web Query uses the paths defined in the Data Values Global
Cache Paths setting.

If no IBFS Paths are defined in this setting, then no data source values are cached. This is
the default value.
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If one or more IBFS Paths are defined in this setting, then data values retrieved from all of
the resources identified in those paths can be included in the Data Values User Cache for
an individual user. If this setting must include multiple paths, they must be separated by a
semicolon (;) with no space following, as shown in the following example: /EDA/
EDASERVE/retail_samples;/EDA/EDASERVE/ibisamp.

Paths defined in this setting use the IBFS Path format. At a minimum, they must include
the /EDA IBFS subsystem component, followed by the name of the Server Node. Shorter,
higher-level paths define a broad range of folders and the Master Files they contain.
Longer paths that extend to a lower level define a narrower range of application folders
and Master Files. Paths can extend down to the level of an individual application folder or
a single Master File.

To include multiple folders or Master Files in this setting, you can use a short, higher-level
path that includes a range of folders, or a series of longer and more detailed paths that
identify a very specific group of folders and Master Files. If this setting must include
multiple paths, each one must be separated by a semicolon (;) with no space following, as
shown in the following example: /EDA/EDASERVE/retail_samples;/EDA/EDASERVE/
ibisamp.

IBFS Paths in this setting use the following structure. Only the first two components of the
path are required. You can use as many of the remaining path components as you wish to
narrow the focus of the path.

| EDA/ Nodel Appl i cat i onFol der! SubFol der1 ... SubFol der N Resource

where:
EDA

Is the EDA IBFS subsystem. This component is required for all paths. The initial slash
(/) before this component is required.

Node
Is the name of the node. This component is required for all paths.
Appl i cat i onFol der

Is the name of the application folder that contains the resources from which data will
be added to the data values cache.

SubFol der1 ... SubFol der N

Are the names of any folders in the path underneath the application folder that
connect to the end point of the path. Include as many folders as are necessary.

Administering Db2 Web Query for i 9
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Resource

Is the end point of the path. If this is the name of a folder that contains one or more
Master File resources, then data from all Master Files in the folder is included in the
cache. If this is the name of a Master File without the .mas extension, then only data
from this specific Master File is included in the cache.

Note: Paths to any folders or Master Files identified in the Data Values User Cache Paths
setting take precedence over those identified in the Data Values Global Cache Paths
setting. This means that if the same path appears in the Global Cache Path setting and
the User Session Class Path setting, then data retrieved from the Master Files in that path
moves into the User Session Cache, instead of the Global Cache.

Data Values Global Cache Paths

Identifies the IBFS Paths to those resources whose data source values can be made
available to all users without restriction in the Global Data Values Cache.

The paths defined in this setting should only identify resources that contain data that is
not subject to DBA or row-level security restrictions. For calls to cache resources that
contain data that is subject to these restrictions, Web Query uses the paths defined in the
Data Values User Cache Paths setting.

If no IBFS Paths are defined in this setting, then no data source values are included in the
Data Values Global Cache. This is the default value.

If one or more IBFS Paths are defined in this setting, then data values retrieved from the
resources identified in those paths are included in the Data Values Global Cache.

Paths defined in this setting use the IBFS Path format. At a minimum, they must include
the /EDA IBFS subsystem component, followed by the name of the Node. Shorter, higher-
level paths define a broad range of folders and the Master Files they contain. Longer paths
that extend to a lower level define a narrower range of application folders and Master Files.
Paths can extend down to the level of an individual application folder or a single Master
File.

To include multiple folders or Master Files in this setting, you can use a short, higher-level
path that includes a range of folders, or a series of longer and more detailed paths that
identify a very specific group of folders and Master Files. If this setting must include
multiple paths, each one must be separated by a semicolon (;) with no space following, as
shown in the following example: /EDA/EDASERVE/retail_samples;/EDA/EDASERVE/
ibisamp.
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IBFS Paths in this setting use the following structure. Only the first two components of the
path are required. You can use as many of the remaining path components as you wish to
narrow the focus of the path.

| EDA/ Nodel Appl i cat i onFol der! SubFol der1 ... SubFol der N Resource

where:
EDA

Is the EDA IBFS subsystem. This component is required for all paths. The initial slash
(/) before this component is required.

Node
Is the name of the node. This component is required for all paths.
Appl i cat i onFol der

Is the name of the application folder that contains the resources from which data will
be added to the data values cache.

SubFol der1 ... SubFol der N

Are the names of any folders in the path underneath the application folder that
connect to the end point of the path. Include as many folders as are necessary.

Resour ce

Is the end point of the path. If this is the name of a folder that contains one or more
Master File resources, then data from all Master Files in the folder is included in the
cache. If this is the name of a Master File without the .mas extension, then only data
from this specific Master File is included in the cache.

Data Values Cache Paths to Exclude

Identifies the IBFS Paths to those folders or Master Files within the paths defined in the
Data Values Global Cache Paths or the Data Values User Cache Paths settings whose
values should be not be included in these caches.

If no IBFS Paths are defined in this setting, no data values are excluded from the individual
resources or folders defined within the paths in the Data Values Global Cache Paths or the
Data Values User Cache Paths settings. This is the default value.

If one or more IBFS Paths are defined in this setting, data values from the individual
resources or folders defined within these paths are excluded from the Global Data Values
Cache and from individual User Session Caches even though the folder or directory in
which they are contained is subject to caching.
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Paths defined in this setting use the IBFS Path format. At a minimum, they must include
the /EDA IBFS subsystem component, followed by the name of the Server Node. Shorter,
higher-level paths define a broad range of folders and the Master Files they contain.
Longer paths that extend to a lower level define a narrower range of application folders
and Master Files. Paths can extend down to the level of an individual application folder or
a single Master File. Typically, this setting requires longer and more specific paths in order
to identify the individual folders or Master Files that must be excluded from the paths
defined in the other data cache settings.

When this setting includes multiple paths, each one must be separated by a semicolon (;)
with no space following, as shown in the following example: /EDA/EDASERVE/
retail_samples;/EDA/EDASERVE/ibisamp.

IBFS Paths in this setting use the following structure. Only the first two components of the
path are required. You can use the remaining components to narrow the focus of the path.

| EDA Nodel Appl i cat i onFol der! SubFol der1 ... SubFol der N Resour ceFol derl
Resour ce

where:
EDA

Is the EDA IBFS subsystem. This component is required for all paths. The initial slash
(/) before this component is required.

Node
Is the name of the node. This component is required for all paths.
Appl i cat i onFol der

Is the name of the application folder that contains the resources whose data will be
excluded from the data values cache.

SubFol der1 ... SubFol der N

Are the names of any folders underneath the application folder that connect to the end
point of the path. Include as many folders as are necessary.

Resource

Is the end point of the path. If this is the name of a folder that contains one or more
Master File resources, then data from all Master Files in the folder is excluded from
the cache. If this is the name of a Master File without the .mas extension, then only
data from this specific Master File is excluded from the cache.
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Report Output Cache

Indicates whether or not report output is cached. The following values are available:
d Off. Report output is not cached. This is the default value.

. On. Report output can be cached, and the Properties dialog box on the Legacy home
page displays the Report Output Cache Rule Name field.

.4 Hidden. Report output can be cached, but the Properties dialog box on the Legacy
home page does not display the Report Output Cache Rule Name field.

Report output is information retrieved from the in response to report or chart procedure
queries and includes data values, column titles, and formatting features.

Note: The Report Output Cache Rule Name field displays a text string that identifies the
rule that governs the way in which report output data is cached. These rules determine if a
cache is available to everyone, available only to the user that requested the data, or if it
can be shared by the members of the group to which that user is assigned.
Reference: Bl Portal Settings
Bl Portal settings configure the display and behavior of the Bl Portal.
Sign-in Message

Specifies a custom message that displays in the Messages dialog box when a user signs
in. You can enter plain text or HTML tags for text, links, and images, into this field. If you
leave this field blank, the Messages dialog box does not display.

The following HTML tags may be used in the sign-in message:
<I>, <br>, <b>, <u>, <a href>, </a>, <img>.
Sign-in Page Links
Determines whether the Db2 Web Query Sign in page displays or hides links.

When this check box is selected (True), the Db2 Web Query Sign in page displays
additional text and links to additional information or support sites. This is the default
setting.

When this check box is cleared (False), the Db2 Web Query Sign in page does not display
any additional supporting text of links, and limits the display to the Screen Title, User
Name, Password, and Sign in button.
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Session Timeout

Controls the session timeout value, which limits the amount of time users can remain idle
before a session timeout takes place. This setting is defined in minutes, for example,
IBI_Session_Timeout=120.

Reference: Client Settings

14

Client settings configure miscellaneous Client options.
Maximum Response Window Size

Defines the maximum size, in bytes, allowed for responses in the original window when
using Internet Explorer.

Responses larger than the size identified in this setting will be launched in a new window,
to ensure that it will open without errors. If this setting is blank, no maximum limit is
applied. The default value is 400,000 bytes.

Excel Server URL

Identifies the location of the resource that Web Query uses to render output in the Excel
2007 file (.xIsx) format.

The Excel Server URL drop-down list contains two options:

- Reporting Server JSCOM (labeled as Default). Directs output to the JSCOMS3 listener
on the Reporting Server, which will then render the output in the Excel file format. The
URL used by this setting is the URL of the JSCOMS3 listener. Use this option if you need
to support SSL or any type of authentication other than the default internal security.
Web Query is configured for JSCOM, overriding the default option.

- Default. Directs output to the IBIExcel Servlet on the mid tier, which will then render the
output in the Excel file format. The URL used by this setting is the Default URL for Web
Query. Use this option if you do not need to support SSL or any type of authentication
other than the default internal security. This is the default option.

Graph Server URL

Identifies the location of the resource that Web Query uses to render output in graph
image file format.

The Graph Server URL drop-down list contains two options:
-1 Reporting Server JSCOM. Directs output to the JSCOMS3 listener on the Reporting
Server, which will then render the output in graph image file format. The URL used by

this setting is the URL of the JSCOM3 listener. Use this option if you need to support
SSL or any type of authentication other than the default internal security.

IBM
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Reference:

-1 Default. Directs output to the IBIGraph Servlet on the mid tier, which will then render
the output in graph image file format. The URL used by this setting is the Default URL
for the Web Query. Use this option if you do not need to support SSL or any type of
authentication other than the default internal security. This is the default option.

This option is required on z/0S. In all other environments, JSCOM3 is the
recommended configuration option.

Transin-Transout

Is a fully qualified Java class that does the transin and transout processing (processing of
a request to and output returned by the Reporting Server) for a plug-in for the Servlet
version of the client. This class must implement the WFTransInOutinterface Java class. For
example, one use of this class can be to enable data that is passed between the
Reporting Server and the Servlet to be parsed for bi-directionality (left/right versus right/
left strings).

Plugin Class

Specifies the qualified name of a plug-in class to be invoked by the Db2 Web Query
Servlet. By default, this variable is set to ibi.webfoc. WFEXTDefault, which is the default
plug-in supplied with Dd2 Web Query that contains several useful functions.

Diagnostics/Tracing Settings

Diagnostics/Tracing Settings determine specific features about system tracing and logging
operations for your installation of Web Query.

Test Pages

Enables a page for testing HTTP requests and for testing RESTful web services. This check
box is selected, by default. You may wish to disable this page in a production environment.

The URLs for the HTTP request test page are:

http:// host: port/ context _root/WServl et ?l BFS1_acti on=TEST

and

http:// host: port/ context _root/WServl et?l BFS1_acti on=TEST1
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Automatic session trace level

Establishes the default trace level for Web Query Sessions. The session trace level
assigned to this setting appears, by default, in the Tracing Level list fields on the main
page of the Session Viewer. Trace levels identify the level of events captured in a trace
file. They range from Basic, which only captures traces of high level events, to Server,
which captures traces of all events. Administrators can override this default value for
individual sessions. By default, this value is set to Off, meaning that no traces are
captured.

Default options for FEX tracing

Establishes the default level of echo traces and SQL Traces captured from the execution of
FEX file commands. In a FEX file, the &ECHO variable displays command lines as they
execute, in order to test and debug procedures. The level of traces captured from all SQL
request and response events. This value is set to Echo On, SQL On, by default, activating
both Echo and SQL tracing for an FEX file. Administrators can override this value with any
of the other setting combinations identified in the list.

Enable javascript error reporting

Activates the display of JavaScript error messages in the event.log file and the Session
Viewer. Values in this setting are:

- On. Adds entries recording JavaScript errors to the event.log file and captures them in
the Session Viewer and in the Session Monitor. This is the default setting.

- Off. Disables the logging feature. However, when using the Session Viewer, JavaScript
errors are still added to traces in the Session Viewer and as entries in the event.log
file.

1 Never. Disables this feature entirely.

As a best practice, we recommend the inclusion of JavaScript errors in the event.log file
and in Session Viewer traces.

Log all URLS when completed

Establishes the default level of URL request message logging for all sessions. All URL
request log entries are posted to the requests log file, located on the Log Files page of the
Diagnostic tab in the Administration Console. Administrators can override this default value
for individual sessions, by selecting a different log level in the requests entry of the Log
Files page. Values in this setting are:

- Off. Does not log URL request events. This is the default setting.

IBM
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-1 On. Logs all URL request events. Log entries for HTTP Post messages do not include
data.

. Full. Logs all URL request events. Log entries for HTTP Post messages include data
delivered with the Post request.

Web Services SOAP Detail
Displays detailed error messages in the SOAP XML response. This check box is selected,
by default. If cleared, this setting suppresses details that administrators may not want to
disclose to the end user.
Reference: ESRI Settings
ESRI settings define the connection to the local application that supports Esri-based maps.
ESRI On Premise

Identifies the path to the internal ArcGIS JavaScript API Source used to develop Esri-based
maps for Web Query. This setting is blank, by default, meaning that the use of an internal
source is not activated. To activate the use of an internal ArcGIS JavaScript API to develop
Esri maps, type the path to it in this setting, typically, /web_resource/arcgis_api.

The default API that should be referenced by this setting is the ArcGIS API for JavaScript,
version 3.15, which can be found at https://js.arcgis.com/3.15/. The ArcGIS JavaScript API
zip file is available for download from https://developers.arcgis.com/downloads/ .

For more information about the Esri ArcGIS Javascript API, see https://
developers.arcgis.com.
Reference: Other Settings
Other settings determine miscellaneous configuration settings.
Enable OLAP

Enables OLAP settings and functionality. When this check box is selected, OLAP
functionality appears in the following location:

.4 InfoAssist. On the Auto Drill and Analysis menu: All OLAP-related features including the
OLAP Options panel, OLAP panel, OLAP Ribbon, and OLAP Reports.

This check box is not selected, by default.
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Reference: Parameter Prompting Settings
Parameter Prompting settings determine parameter prompting behavior in Web Query.
Managed Reporting

Enables or disables parameter prompting for all Managed Reporting requests. Possible
values are:

- Off. Turns off parameter prompting at the site level.

- Run with Default Values (XMLRUN). Prompts for amper variables that were created
with the -DEFAULT command when there is another amper variable that does not have a
value assigned. This is the default value.

- Always Prompt (XMLPROMPT).Prompts for amper variables that were created with the
-DEFAULT command and any other amper variable that does not have a value.

Managed Reporting when Prompt Parameters Property Unset

Enables or disables parameter prompting for Managed Reporting procedures (FEXes) when
Managed Reporting (IBIMR_PROMPTING) is set to Always Prompt (XMLPROMPT) or Run
with Default Values (XMLRUN), and the Prompt for Parameters check box is not selected in
the FEX Properties dialog box. Possible values are:

- Off. Turns off parameter prompting.

- Run with Default Values (XMLRUN). Prompts for amper variables that were created
with the -DEFAULT command and any other amper variable that does not have a value.
This is the default value.

- Always Prompt (XMLPROMPT). Prompts for amper variables that were created with
the -DEFAULT command when there is another amper variable that does not have a
value assigned.

Self Service

Enables or disables amper auto prompting. Possible values are:
- Off. Turns off auto prompting. This is the default value.

- Run with Default Values (XMLRUN). Prompts for amper variables that were created
with the -DEFAULT command and for any other amper variable that does not have a
value.

- Always Prompt (XMLPROMPT). Only prompts for amper variables that were created
with the -DEFAULT command when there is another amper variable that does not have a
value assigned and, therefore, will be prompted for.
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- Display XML (Debug with syntax error checking) (XML). Displays the XML document
describing the amper variables in the browser. This setting is used internally, and is
recommended for debugging and syntax error checking purposes only.

.4 Display XML (Debug) (XMLCHECK). Displays the XML document describing the amper
variables in the browser. This setting is used internally, and is recommended for
debugging purposes only.

Note: Managed Reporting uses a separate variable setting, which is IBIMR_PROMPTING.
Preselect all values for static list controls

Activates the automatic selection of all values in Responsive Autoprompt multiselect static
selection list parameters at runtime, by default.

If this check box is selected (TRUE), Responsive Autoprompt selection list parameters that
contain multiselect static lists are automatically assigned FOC_ALL as their initial selection
value, by default, causing these lists to automatically display all values as selected at
runtime. However, if a multiselect static list designates a default value for display, that
value overrides the automatic assignment of FOC_ALL as the initial selection value, and
that default value is displayed as the initial selection instead.

If this check box is cleared (FALSE), parameters that contain multiselect static lists are not
automatically assigned FOC_ALL as the initial selection value, by default, and all items
within the list are not selected automatically at runtime. If a multiselect static list contains
a designated default value, that value is displayed, by default. To include all values from
the static selection list in a query, a user must manually select the All Values option or
individually select all values in the list.

This check box is cleared (FALSE), by default.
Default Autoprompt Template
Specifies the template that defines the layout of the autoprompt interface.
.d Designer. Specifies the use of the Designer Autoprompt implementation and the

Designer Autoprompt template. In this template, the Autoprompt interface uses the
Designer page format. This is the default value.

.d Responsive. Specifies the use of the responsive implementation and the
autoprompt_jgm.jsp template.

.4 HTML Top. Specifies the use of the HTML-based implementation and the
autoprompt_top.html template, which displays parameters horizontally at the top of the

page.
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-1 HTML Top Checked. Specifies the use of the HTML-based implementation and the
autoprompt_top_checked.html template. In this template, the Run in a new window
check box is selected, specifying that all reports open in a new window, by default.

Null Behavior

Specifies the value (_FOC_NULL or FOC_NONE) that the client assigns to the amper
variable when the dynamic multi-select list No Selection value is selected. The default
value is _FOC_NULL.

Auto Describe
Activates automatic indexing of report and chart parameters. If this check box is selected
(TRUE), when users save reports or charts, Web Query automatically indexes the
parameters on which they are based, making information about these parameters
immediately searchable, and delivering more timely and comprehensive search results.

This check box is selected (TRUE), by default.

Reference: Db2 Web Query Spreadsheet Client Settings
The Spreadsheet Client settings determine how Spreadsheet Client performs authentication.
Security

Specifies the type of sign in used by Db2 Web Query Spreadsheet Client. Permitted values
are Reporting Server and Managed Reporting. The default value is Managed Reporting (MR)
and should not be changed.

Form Only

Applies when MR authentication is selected for the Security setting. Permitted values are:

- Yes. Users may not create their own reports using InfoAssist+, but may only use
predefined ad hoc forms.

1 No. Users may use predefined ad hoc forms or create their own reports, using

InfoAssist+. The default value is No (clear check box).

Reference: Security
Security settings govern authentication for the Web Query environment.
Enable Password Change

Allows users to change their Web Query user ID password. The default is selected.

20 IBM



1. Db2 Web Query Administration Console I

Sign-out URL

Defines the URL to which a user ID is redirected to on sign out of Db2 Web Query. The
default is /, which redirects the user to the Db2 Web Query Sign in page.

For Kerberos configurations, set the URL to logon/logoff.jsp or to another preferred URL,
rather than the default of /.

Changing Web Query Client Settings in Web Query

The client configuration settings are grouped into categories under the Configuration menu in
the Administration Console. The term Initial Value next to a setting means that the value shown
initially is the installation default value and that it can be overridden by setting the variable
explicitly in the URL request.

Understanding Custom Settings

The Custom Settings page allows you to customize your installation of Web Query by typing
customized values for standard settings.

When you save updates to settings that you type into the Customized Setting text box, they are
transferred to the site.wfs file, located in the /qibm/UserData/qwebqry/base80/
client/wfc/etc directory. When you use this page to assign new values to settings, they
override the default values assigned to them. These overrides are carried over as you upgrade
to new versions.

After you save a custom setting, the text continues to display on this page. You can use

comments to identify specific updates and additional information about them.
Procedure: How to Configure Custom Settings

Only an administrator can configure settings on the Custom Settings page.

1. Inthe Administration Console, on the Configuration tab, click Custom Settings.

2. Under the final comment statement at the top of the Custom Settings text box, or the
most recent custom setting entry, type the variables, settings, commands, or comments
that comprise the custom settings.

Use the format required by the application or operating system that will execute the
command.

To help track changes to custom settings, use comments to identify and separate
individual changes.

3. To store your custom settings in an encrypted format, select the Encrypt check box.

Note: Even when you select this check box, settings continue to appear in an unencrypted
format in the Custom Settings text box.
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When your configuration is complete, click Save.
When you receive a confirmation message, click OK.

When the Custom Setting page clears, click Custom Settings under the Application
Settings folder to see your updated comments, settings, or commands in the Custom
Settings text box.

Customizing the Dynamic Language Switch

You can customize the languages that are made available on Sign in pages by activating the
Dynamic Language Switch.

Procedure: How to Customize the Dynamic Language Switch
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1.

In the Administration Console, on the Configuration tab, under the Application Settings
folder, click Dynamic Language Switch.

The Dynamic Language Switch page opens with a list of the languages made available by
the code page selection in the National Language Support page. By default, the Enable
Dynamic Language check box is not selected and all of the language check boxes are
deactivated.

Select the Enable Dynamic Language check box to activate the check boxes for all of the
available languages displayed in the panel, as shown in the following image.

Client Code Page: 85001 - Unicode (UTF-8)

¥ Enable Dynamic Language

I Locale Language Code
I Chinese - Simplified GB zh
= Chinese - Traditional Big-3  tw
I English en
[ French - Canadian fc
[ French - Standard fr
¥ Gerrman de
v Ttalian it
= Japanese ia
¥ Portuguese - Brazilan br
v Spanish g5

Selecting the Enable Dynamic Language check box and one or more languages activates
the display of the Language menu on all of the Sign in pages.

Select the check box next to each of the languages that you want to appear on the Sign in
pages and in the Language menu.
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4. Select the check box in the Locale heading if you want all of the languages to appear in
the Language menu on the Sign in pages.

5. Click Save.
6. When you receive the Successfully Saved message, click OK.
Note: To remove languages from the Language menu on the Sign in pages, clear the check
boxes next to the languages you want to remove.
Understanding Redirection Settings

You can view or edit redirection settings for the Db2 Web Query Client though the Redirection
Settings page of the Administration Console. However, you should not alter Redirection
Settings without consulting Support.

Redirection settings allow users to save report output in a temporary directory when a request
is executed. Then, the browser makes an HTTP call to retrieve the temporary stored output for
display.

If redirection is turned off, the report output displays in the browser immediately after the
request is executed.
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To change redirection settings in the Administration Console, on the Configuration tab, click
Redirection Settings. The Redirection Settings panel opens, as shown in the following image.

Redirection Settings

WebFOCUS Content Server Save Client IBFS
Extension Type Format Redirect Extension Report Extension Format
Tt text/plain ascii no ACCESS no Ao aAsCil
.brmp irmage/brmp hinary no 1 Bump no ' .brmp hinary
.cfg text/cfg ascii no ' M/ A no ' .cfg ascii
.Class javal* binary no ' M/ A no | .cass ascii
.55 text css binary no | css no | .css ascii
L5V application/csv ascii yes - MfA no .5V ascii
dif application/x-dif ascii yes - M/A no | .dif ascii
.doc application/msword ascii yes DoC no | .doc aAsCil
Jdocx applicationfvnd.openxml  hinary no | pocx no | docx hinary
297 application/vnd.ms-excel asci no ' M/ A no | .e07 ascii
LBIT text/plain ascii no | ErRRORS no | e ascii
fex text/plain ascii no | Focexec no | fex ascii
foc application/foc binary no FOCUS no 1 foc binary
for text/plain ascii no - M/A no | for ascii
ftm application/x-ftrm ascii no | FocTEMP no | &m aAsCil
.afa application/gfa hinary no ' M/ A no ' .ofa hinary
.aif image/aif binary no | GIF no ' .gif binary
hex text/plain ascii no ' M/ A no | hex ascii

Procedure: How to Change Redirection Settings
1. In the Administration Console, on the Configuration tab, click Redirection Settings.

2. In the Redirect column, select yes on a row to redirect the output to a temporary directory
for the specified extension.

3. In the Save Report column, select yes to prompt users in the browser to open or save
report output. When Save Report is set to yes, the report output retains the Save As
name, if specified in the request.

For example, specifying ON TABLE PCHOLD AS MYREPORT FORMAT PDF in a request and
setting Save Report to yes for the .pdf extension enables a user to open or save the
output as MYREPORT.pdf. The Save As name specified is returned to the browser in

uppercase. If Save Report is set to yes and no Save As name is specified in the request, a
random file name is generated.
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Important: You must do the following to use the Save Report functionality for GRAPH
requests (specified with a PNG, SVG, GIF, JPEG, or JPG format in the procedure):

. Set Save Report to yes for the .htm Extension.

Running a server-side GRAPH request creates an HTM file that contains a link to the
actual graph output, which is stored as a temporary image file with
a .jpeg, .jpg, .gif, .svg, or .png extension.

.4 When you execute a GRAPH request, if you select the Save option when prompted to
open or save the output, the output is saved to an HTM file using only a reference to
the graph image, which will eventually expire and be deleted from the server (according
to the temporary file expiration settings in the Client Configuration).

d To preserve the output of the GRAPH request, open the saved HTM file, right-click the
graph image, and select Save Picture As to save it to disk permanently. You can then
substitute an absolute reference to the saved image file in the returned HTM output
file.

If you want to encrypt the redirection settings, select the Encrypt check box at the bottom
of the screen.

Click Save to save your changes in the Redirection Settings panel.

InfoAssist Properties

Reference:

Settings in the InfoAssist Properties page of the Administration Console determine the display
and use of features in the InfoAssist tool that opens when creating or updating content.

To open the InfoAssist Properties page, in the Administration Console, scroll down to the
bottom of the Configuration tab menu, and then click InfoAssist Properties. You can then
enable or disable options for the InfoAssist tool.

Understanding InfoAssist Home Tab Properties

The InfoAssist Home tab enables you to control the most commonly used properties and
options from the Home tab. These properties are:

Use Live Preview Mode

Determines whether InfoAssist opens in the Live Preview mode or the Query Design View,
by default. When Yes is selected, InfoAssist opens in the Live Preview mode as the default.
When Yes is not selected, InfoAssist starts with the Query Design View. If the Allow User
Override check box is selected for this option, users can change the setting specified by
the administrator.
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Record Limit

Enables the Record Limit menu of the Home tab. If Show is not selected, the Record Limit
menu is removed from the InfoAssist interface.

Themes

Provides InfoAssist users with various color-coded StyleSheet themes that can be used to
style reports and charts. Users can select standard themes, or select customized
cascading style sheet themes created by your organization.

Page Heading

Enables the Header & Footer menu of the Home tab. This menu can be used to add a
heading or footing to each page of the report output.

Report Heading

Enables the Header & Footer menu of the Home tab. This menu can be used to add a
heading or footing to the first page of the report output.

Understanding InfoAssist Format Tab Properties

For reports or charts, InfoAssist displays a list of output file format options, such as HTML,
PDF, or Excel, in the Format Group of the Home tab. Other options that make additional layouts
and display features available when creating a report or chart appear on the Format tab itself.
You can control the display of both types of options through the settings contained in this
section.

Note: Settings in this section do not affect the display of Format tab features for
visualizations.

PDF Analytic Document Format

Enables the use of the PDF Analytic Document Format in InfoAssist. This format adds the
portability and interactive enhancements of In-Document Analytics to PDF reports. The
resulting output is designed for offline analysis and includes all of the data and JavaScript
tools required to support analytic operations such as filtering, sorting, and charting in a
self-contained report.

When this check box is selected, this format is available as an option in the Output File
Format list that opens from the Format group of the InfoAssist Home Page ribbon. It is also
available for selection as a default output format from the Report Output Format list, the
Chart Output Format list, and the Document Output Format list in the Tool Options Dialog
Defaults section of the InfoAssist Properties page.

This check box is cleared, by default.
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HTML Analytic Document Format

Enables the use of the HTML Analytic Document Format in InfoAssist. This format adds the
portability and interactive enhancements of In-Document Analytics to HTML reports. The
resulting output is designed for offline analysis and includes all of the data and JavaScript
tools required to support analytic operations such as filtering, sorting, and charting in a
self-contained report.

When this check box is selected, this format is available as an option in the Output File
Format list that opens from the Format group of the InfoAssist Home Page ribbon. It is also
available for selection as a default output format from the Report Output Format list, the
Chart Output Format list, and the Document Output Format list in the Tool Options Dialog
Defaults section of the InfoAssist Properties page

This check box is selected, by default.
Additional HTML Formats for Chart

Enables the use of the PNG, JPEG, GIF, and SVG output formats. The default value is PNG.
PNG is not available as a format for chart output.

Additional PDF Formats for Chart

Enables the use of the PDF/SVG and PDF/GIF output formats. The default value is PDF/
SVG.

Excel 2000 Format

Enables the use of the Excel 2000 spreadsheet output format. The Excel 2000 format
supports most StyleSheet attributes, allowing for full report formatting. The computer on
which the report displays must have Microsoft Excel 2000 installed.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section.

This check box is selected, by default.
Excel 2000 Formula

Enables the use of the Excel 2000 formulas when the Excel 2000 Format option is
selected.

This check box is selected, by default.
Excel 2007 Format

Enables the use of the Excel 2007 spreadsheet output format. The computer on which the
report displays must have Microsoft Excel 2007 installed.
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When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist Properties page.

This check box is selected, by default.
Excel 2007 Formula

Enables the use of the Excel 2007 formulas when the Excel 2007 Format check box is
selected.

This check box is selected, by default.
Excel Pivot

Enables the use of the Excel 2000 PivotTable output format. PivotTable is an Excel tool for
analyzing complex data.

This check box is not selected, by default.
Excel CSV
Enables the use of the comma separated values (CSV) file format.

When this check box is selected, the Excel CSV format option is available for use in
InfoAssist, and it appears on the Home tab in the Format group options list under the Excel
format option. When it is cleared, this option is not available, and it does not appear in the
Format group options list.

This check box is selected, by default.
HTML Format
Enables the use of the HTML page report format.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist Properties page.

InfoMini Run Immediate

If Enable is selected, reports run immediately when InfoMini first launches. This setting is
enabled, by default.

Other Chart Types

Allows the creation of more complex graph output types, such as spectral maps, gauge
charts, and Pareto charts.
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Pages on Demand

Enables the display of report output one page at a time. Users can use the navigation
menu at the bottom of the output screen to view each page. This option is activated only
when HTML or active report output format is selected.

PDF Format
Enables the use of the PDF report format.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist Properties page.

PowerPoint 2000 Format

Enables the use of the PowerPoint® 2000 document output format. The computer on
which the report appears must have Microsoft PowerPoint 2000 or higher installed.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist Properties page.

PowerPoint 2007 Format

Enables the use of the PowerPoint® 2007 document output format. The computer on
which the report appears must have Microsoft PowerPoint 2007 or higher installed.

When this check box is selected, this output format option is available for use when
selected from the Output Format drop-down menus in the Tool Options Dialog Defaults
section of the InfoAssist Properties page.

Stack Measures

Displays all numeric measure field names in the first column of the report output, with the
corresponding numeric data values displayed across time in a column for each selected
time period. The Stack Measures feature is activated only when HTML, Excel, or
PowerPoint output format is selected.

User Selection

Allows users to change the output type of their reports at run time.
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Understanding InfoAssist View Tab Properties

Enables InfoAssist users to customize the view of different report components in the InfoAssist
tool, such as the design mode, output location, and data view. You can configure the following
properties in the InfoAssist View tab:

Display View Tab

Enables the View tab and all of its menu options. If this is not selected, the View tab is
removed from the InfoAssist interface.

Data Panel

Allows the user to customize Data Panel settings. Values are Logical (default), List, and
Structured.

Query Panel

Allows the user to customize the view of the query components, such as Filters, Column
and Row labels, and Measures when building a report. Values are Tree (default), Area 2x2
(2 columns by 2 rows), Area 1x4 (1 column by 4 rows). If the Allow User Override check box
is selected for this option, users can change the setting specified by the administrator.

Understanding InfoAssist Tool Options Dialog Defaults Properties

Settings in the Tool Options Dialog Default section enable administrators to specify default
tool settings. If the Allow User Override check box is selected for an option, users can change
the setting specified by the administrator. However, the administrator cannot specify a default
value that has already been disabled in one of the other groups. For example, if you have
disabled the PDF Analytic Document Format option in the Format Tab section, you will receive
an error message if you attempt to set that format as a default Report, Chart, or Document
Output Format in the Tools Options Dialog Defaults section.

Report Output Format

Sets the default format for reports. Valid values are HTML, HTML Analytic Document, PDF,
PDF Analytic Document, EXLO7, EXL2K, PowerPoint 2000, and PowerPoint 2007. The
format options in this list are available only when their corresponding check box is
selected in the Format Tab section of the InfoAssist Properties page. If that check box is
cleared, you receive a message warning you that the format option is not enabled when
you select it from this list. The default value is HTML.
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Chart Output Format

Sets the default format for charts. Valid values are HTML, HTML5, HTML Analytic
Document, PDF, PDF Analytic Document, EXLO7, EXL2K, PowerPoint 2000, and PowerPoint
2007. The format options in this list are available only when their corresponding check box
is selected in the Format Tab section of the InfoAssist Properties page. If that check box is
cleared, you will receive a message warning you that the format option is not enabled
when you select it from this list. The default value is HTML5.

Document Output Format

Sets the default format for documents that are generated in . Valid values are HTML, HTML
Analytic Document, PDF, PDF Analytic Document, EXLO7, EXL2K, PowerPoint 2000, and
PowerPoint 2007. The format options in this list are available only when their
corresponding check box is selected in the Format Tab section of the InfoAssist Properties
page. If that check box is cleared, you will receive a message warning you that the format
option is not enabled when you select it from this list. The default value is PDF.

Page Orientation

Sets the default page orientation for reports and charts. Valid values are Portrait and
Landscape. The default value is Portrait. If the Allow User Override check box is selected for
this option, users can change the setting specified by the administrator.

Page Size

Sets the default page size for reports and charts. Valid values are A3, A4, A5, Letter,
Tabloid, Legal, PPT-SLIDE, and Large Size. The default value is Letter. If the Allow User
Override check box is selected for this option, users can change the setting specified by
the administrator.

Data Preview Method

Sets the default action for whether reports are previewed using sample data or actual data
from the data source. Valid values are Live and Sample. The default value is Live. If the
Allow User Override check box is selected for this option, users can change the setting
specified by the administrator.

Record Limit

Sets the default maximum number of rows retrieved from the data source when Interactive
Design view is selected. This feature is useful in reducing response time if users are
working with a large amount of data. It is applicable only when developing the report. The
record limit setting will not affect the report output at run time. Valid values are, All, 1, 10,
50, 100, 500, 1000, 2000, 5000, 10000 rows. The default value is 500 rows. If the Allow
User Override check box is selected for this option, users can change the setting specified
by the administrator.
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Output Target

Sets the default location for reports and charts. Valid values are Single tab, New tab,
Single window, and New window. The default value is Single tab. If the Allow User Override
check box is selected for this option, users can change the setting specified by the
administrator.

In-Document Analytics

Sets the default value for the In-Document Analytics setting in the Procedure Settings
dialog box, which opens from the InfoAssist Quick Access toolbar. Valid values are
Designer Style and Legacy. In the InfoAssist Properties page setting, the Designer Style
value is selected, by default.

The value assigned to this setting determines the default interface for InfoAssist to use
when running reports, charts, and documents based on the HTML Analytic Document
format. When users create new HTML Analytic reports, charts, and documents in
InfoAssist, they can override the default value established in the InfoAssist Properties
page setting by selecting an alternative option from the In-Document Analytics setting that
appears in the Procedure Settings dialog box.

InfoAssist/Portal StyleSheet

Sets the StyleSheet to be used for InfoAssist and the Portal. Click Change Stylesheet to
open the Browse predefined template files window. The value displayed, by default, is
Warm.sty.

If the Allow User Override check box is selected for this option, users can change the
setting specified by the administrator.

Visualization StyleSheet

Sets the StyleSheet to be used when creating visualizations. Click Change Stylesheet to
open the Browse predefined template files window. The value displayed, by default, is
Warm.sty.

If the Allow User Override check box is selected for this option, users can change the
setting specified by the administrator.

Encode HTML

Encodes script tags within data, so that the tags are replaced and not executable in a
browser. The default value is Yes. This includes the ON TABLE SET HTMLENCODE ON
command in the procedure.
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Enable Pages On Demand

Allows InfoAssist users to view report output one page at a time. The user can use the
navigation menu at the bottom of the output screen to view each page. This option is
activated only when HTML or active report output format is selected.

Rows retrieved from cache

Establishes how many rows of cached data stored in a binary file are returned to the
output window at one time. The default value is 100 rows.

HTML Freeze Height

Determines how the Freeze option, located on the Format tab in the Navigation group of
the InfoAssist ribbon, automatically freezes the height of a report area.

If the AutoFit value is assigned to this setting, reports produced when the Freeze option is
selected automatically fit the height of the window or pane in which they appear. This is
the default value.

If the Fixed value is assigned to this setting, reports produced when the Freeze option is
selected are set automatically to a fixed height of four inches, regardless of the size of the
window or pane in which they appear.

HTML Accordion

Determines whether the Accordion option, located on the Format tab in the Navigation
group of the InfoAssist ribbon, displays accordion reports that automatically resize data to
fit the container in which they appear.

If the AutoFit value is assigned to this setting, reports produced when the Accordion option
is selected automatically resize the display of data to fit the size of the container in which

they appear, and automatically adjust column widths based on the size of the largest data
value or column title. This is the default value.

If the legacy value is assigned to this setting, reports produced when the Accordion option
is selected do not automatically resize the display of data to fit the size of the container in
which they appear, and do not automatically adjust column widths.

Enabling the Cache Through Global Preferences

In InfoAssist, the cache option enables you to send only the first page of report output using
the Analytic Document Format to the browser and retrieve subsequent pages from a temporary
cache on the InfoAssist. You can enable the cache locally through the Advanced tab of the
Analytic Document Options dialog box in InfoAssist. You can enable the cache option globally
by configuring the relevant InfoAssist Properties settings in the Administration Console.
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How to Enable the Cache Through InfoAssist Properties

You can globally enable the cache for InfoAssist by using settings in the Administration
Console, as described in the following steps:

1. Open the Administration Console.

2. On the Configuration tab, click InfoAssist Properties.

3. On the InfoAssist Properties page, under the Tool Options Dialog Defaults section:
a. Select the Yes checkbox, in the Enable Pages On Demand setting.

b. Accept the default value of 100 in the Rows retrieved from cache setting, or type an
alternative value that conforms to your requirements.

At the bottom of the page, click Save.
When you receive a message that the changes were saved successfully, click OK.

6. Close the Administration Console.

How to Validate the Cache Configuration

You can confirm that uses the global settings you configure in the Administration Console, as
described in the following steps:

1. Open to create a new report or edit an existing report.

2. On the Home tab, in the Format group, click the Output File Format list, and then click
HTML Analytic Document or PDF Analytic Document.

Click the Format tab.
In the Navigation group, confirm that the Pages on Demand option is highlighted.
In the Features group, click Analytic Document Options.

In the Analytic Document Options dialog box, click Advanced.

N o e

Compare the value in the Rows Retrieved field to the value you accepted or typed in the
Rows retrieved from cache setting in the Administration Console.

If the two values are a match, the Administration Console configuration update was a
success. If they do not match, review your configuration of the Administration Console
setting.
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Reference: Understanding InfoAssist File Options

Determines which of the following file types can be selected by users when creating and saving
HOLD files:

Binary

Stores report or chart data as binary numbers in numeric fields. Binary files use the
extension (*.ftm).

FOCUS

Stores report or chart data as text in a segment structure that conforms to FOCUS
database requirements. FOCUS files use the extension (*.foc).

Comma Delimited with Titles

Stores report or chart data as text in sequence by field. Alphanumeric fields are enclosed
in quotation marks. Fields are separated by commas and are preceded by Field Names.
Comma Delimited with Titles files use the extension (*.csv) (Comma Separated Values).

Plain Text

Stores report or chart data as text in sequence by field without delimiters or field names.
Plain Text files use the extension (*.ftm).

Tab Delimited

Stores report or chart data as text in sequence by field. Fields are separated by tab
characters. Tab Delimited files use the extension (*.tab).

Tab Delimited with Titles

Stores report or chart data as text in sequence by field. Fields are separated by tab
characters, and are preceded with field names. Tab Delimited with Titles files use the
extension (*.tab).

Database Table

Stores report or chart data as text in a field structure that conforms to a Structured Query
Language (SQL) Database format. Database Table files use the extension (*.sql).

Database Table output is only available when working against an SQL database.
Hyperstage

Stores report or chart data as text in a field structure that conforms to the Hyperstage
database table format. Hyperstage files use the extension (*.bht).

Hyperstage output is only available when the has a Hyperstage adapter configuration.
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SQL script

Stores report or chart data as text in a sequential field structure that can be imported into
a database table that conforms to the Structured Query Language (SQL) Database format.
SQL Script files use the extension (*.sql).

SQL Script output is only available when working against an SQL database.
XML

Stores report or chart data as text in a field structure that conforms to the rules of the
Extensible Markup Language. Fields are separated by tags that identify content. XML files
use the extension (*.xml).

JSON

Stores report or chart data as text in a structure that conforms to the rules of JavaScript
Object Notations. JSON files use the extension (*.json).

Understanding InfoAssist Chart Type Options
Leaflet Maps

Enables the icons required for the use of Leaflet maps in both chart and visualization
mode of InfoAssist. The two Leaflet map icons enable you to select either a Choropleth or
a Proportional Symbol (Bubble) map based on the Leaflet open-source JavaScript library for
mobile-friendly interactive maps.

In chart mode, these icons are available in the Select a chart dialog box. To open this
dialog box, click Other on the Format tab, in the Chart Types group. In the Select a chart
dialog box, click Map.

In visualization mode, these icons are available in the Select a Visual dialog box. To open
this dialog box, click Change on the Home tab, in the Visual group.

If this setting is not selected, Leaflet map icons do not appear in either location. The
default value is selected.
Understanding InfoAssist Auto Drill Properties

Settings in this section enable the use of drill-down navigation options, which are part of the
Auto Drill functionality.

Single Click Navigate

Enables the use of single click navigation, which is an automatic drill down to the next
level of a dimension within the body of a report or chart made in response to a single click
on a top-level entry or feature.
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By default, this check box is not selected, meaning that single click navigation is disabled,
and top-level Auto Drill entries or features display the Drilldown menu in response to a
single click. If this check box is selected, single click navigation is enabled, and instead of
displaying the Drilldown menu, top-level Auto Drill entries or features automatically refresh
the report or chart with results based on the next lower level of your selected dimension in
response to a single click.

Breadcrumbs

Enables the display of a breadcrumb trail at the top of an Auto Drill report or chart.

By default, this check box is selected, and Auto Drill reports and charts display a
breadcrumb trail. If this check box is cleared, Auto Drill reports and charts do not display a
breadcrumb trail.

In an Auto Drill report or chart, a breadcrumb trail displays a series of links to previous
versions that were generated as you drilled through each level of your selected dimension
to reach the version currently on display.

Restore Original
Enables the display of the Restore Original option in the Drilldown menu.

By default, this check box is selected, and the Restore Original option appears in the
Drilldown menu. If this check box is cleared, the Restore Original option does not appear in
the Drilldown menu.

In an Auto Drill report or chart, the Restore Original option returns you directly to the
original version.

Drill Up
Enables the display of the Drill up option in the Drilldown menu.

By default, this check box is selected, and the Drill up option appears in the Drilldown
menu. If this check box is cleared, the Drill up option does not appear in the Drilldown
menu.

In an Auto Drill report or chart, the selection of the Drill up option refreshes the display
with results based on the next level above the current level of your selected dimension.

Drill Down
Enables the display of the Drill down option in the Drilldown menu.

By default, this check box is selected, and the Drill down option appears in the Drilldown
menu. If this check box is cleared, the Drill down option does not appear in the Drilldown
menu.
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In an Auto Drill report or chart, the selection of the Drill down option refreshes the display
with results based on the next level below the current level of your selected dimension.

Note: In addition to disabling the Drill down option, clearing this setting also removes
hyperlinks from top level report entries and the breadcrumb trail display from reports and
charts. If the Single Click Navigate setting is also cleared, clearing the Drill Down setting
effectively disables Auto Drill navigation tools in reports and charts that contain only the
top level of a dimension value in their design. If the Single Click Navigate setting is
selected, and the report or chart contains entries below the top level, clearing the Dirill
Down setting shifts the Single Click Navigation feature to those lower-level entries.
However, because this setting also suppresses the display of the Drilldown menu, users
will neither be able to restore the original version of the report or chart, nor will they be
able to drill back up to a higher level.

Reference: Understanding InfoAssist Miscellaneous Options
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Use two-part file name

If selected, this option requires the use of two-part file names, which specify the path to
the Master File location. If not selected, a one-part file name must be used instead. The
default value is selected.

Expand Data Source Tree

Determines whether the initial view of the data source tree is expanded or collapsed. If
selected, the tree is expanded. If not selected, the tree is collapsed. The default value is
selected.

Join Tool

Displays the Join menu option on the InfoAssist Data tab. If not selected, the Join menu
option is removed from the Data tab. The default value is selected.

Layout Tab

Enables the Layout tab in the InfoAssist ribbon. If not selected, the Layout tab is removed
from the InfoAssist ribbon. The default value is selected.

Series Tab

Enables the Series tab in the InfoAssist ribbon. The Series tab displays when working with
charts and visualizations. It provides access to charting properties and options in the
Properties, Line, and Pie menus. If not selected, the Series tab is removed from the
InfoAssist ribbon. The default value is selected.
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Enable Path Enforcement

Establishes the default condition of the Enforce Paths container ; that appears at the
top of the Data pane of the Resources panel in the InfoAssist Application Window.

When you move a field from the Data pane into a field container on the Query pane, path
enforcement automatically limits the display of available fields in the Data Source Tree to
those with valid logical connections, based on their multi-path relationships, to the field
that moved into the field container.

When this check box is cleared, the default value for this setting, the Enforce Paths
container is not enabled, by default. Under this condition, the display of available fields in
the Data Source Tree does not change when users move a field into a field container in
the Query pane. Within the InfoAssist session, users can click the Enforce Paths container
to enable path enforcement.

When this check box is selected, the Enforce Paths container is enabled, by default. Under
this condition, fields in the Data Source Tree with no logical connection to a field moved
into a field container in the Query pane are dimmed and unavailable. Within the InfoAssist
session, users can click the Enforce Paths container to disable path enforcement.

Note: When you save a new procedure, the current condition of the Enforce Paths
container is saved with the procedure. When you re-open the procedure in the InfoAssist
Application Window, the condition of the Enforce Paths container is established by the
value stored in the procedure instead of the value assigned to the Enable Path
Enforcement setting.
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Working With HTML5 Chart Extensions

The HTML5 Chart Extensions page contains all currently installed HTLM5 chart extensions, as
shown in the following image.

HTMLS Chart Extensions

| Get more Extensions |

Name: Arc Chart Enabled *
Description: Arc Chart
Version: 1.2.0

J '] API Version: 2.0
Author:  Three D Graphics

Copyright:  Three D Graphics Inc.

com.ibi.arc URL: https://threedgraphics.com

License:
Name: Calendar Heat Map Chart Enabled X

Description: Heat Map chart that has weekdays on one axis and months on the other
Version: 1.3

API Version: 1.0

Author: TIBCO Software

8 Copyright:  TIBCO Software Inc.

com.ibi.calendar URL: hitps:/github. comyibifuf-extensions-chart/t .ibi.calendar

License:

Name: calendar_traditional [] Enable x
sanuary - -
e Description: Traditional Calendar

Version: 1.0

APT Version: 1.0/2.0
Author: TIBCO Software
Copyright:  TIBCO Software Inc.

com.ibi.calendar_traditional URL: https://github.comibi/wf-extensions-chart/tr dar traditional
License:
Name: USA State Cartogram [J Enable x
Description: Cartogram for U.S. States
Version: 110

API Version: 1.0

Author:  TIBCO Software
Copyright:  TIBCO Software Inc.
URL:

License:

com.ibi.cartogram

HTML5 chart extensions expand the standard set of charts to include customized charts
tailored to very specific reporting and data visualization requirements.

Features on this page allow you to upload HTML5 chart extensions, enable or disable their
use, and uninstall them when no longer needed.
Understanding HTML5 Chart Extension Entries

Each HTML5 Chart Extension entry contains details that identify a chart extension and its
origin, and help you determine if a chart extension is appropriate.

Name: Chord Diagram
Description: Chord Diagram
-
’.\ Version: 1.6
on

API Version: 1.0
Author: Three D Graphics

. Copyright:  Three D Graphics Inc.

com.bi.chord URL: https://github.com/ibi/wf-extensions-chart/tree/master/com.ibi.chord
License: BSD 3-clause
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Each entry identifies an HTML5 chart extension with a Name, Description, Version, and API
Version. These details help you identify the chart extension you want to use, and the specific
version of it that best matches your requirements. The Author and Copyright identify the origin
of the chart extension, and the URL links you to the location where you can retrieve additional
copies. License information identifies the type of license, if any, under which the chart
extension is made available to you, and helps you understand any limits on the use of the
chart extension and the rights and obligations licensed users have to the developer.

Understanding the HTML5 Chart Extensions Enable/Enabled Check Box

Every HTML5 Chart Extension entry includes the Enable/Enabled check box that indicates
whether or not the chart extension is available for use. The use of this check box provides
administrators with a second level of availability that enables them to restrict the full
availability of HTML5 Chart Extensions to those that are in active use, while retaining all other
installed HTML5 Chart Extensions in readiness for when they are needed.

When this check box is cleared, it displays the Enable label to indicate that selecting the check
box will make the chart extension available for use, as shown in the following image.

Name: Chord Diagram () Enable X

Description: Chard Diagram
-
\\ Version: 1.6
API Version: 1.0
Authar: Three D Graphics

Copyright:  Three D Graphics Inc.
URL: https://github. com/ibi/wf-exte hart/tree/master/com. ibi.chord

com.ibi.chord

License: BSD 3-clause

HTML5 Chart Extensions that have the Enable check box selected are installed, but they are
not available to users.

When this check box is selected, it displays the Enabled label to indicate that the chart is
already available for use, as shown in the following image.

Name: Chord Diagram Enabled | x

Description: Chord Diagram

-1 .
'\ Version: 1.6
API Version: 1.0

Author: Three D Graphics
Copyright: ~ Three D Graphics Inc.

com.ibi.chord URL: https://qithub.com/ibifwf-extensions-chart/tree/master/com.ibi.chord

License: BSD 3-clause

HTML5 Chart Extensions that have the Enabled check box selected are installed and are
available to developers using InfoAssist+ for their use in chart creation. The files and
directories included in that Chart Extension are identified as eligible for calls from InfoAssist+
and Designer. An icon for that Chart Extension is displayed in the Select a Chart menu that
opens from the Other command in the Chart Type group, on the InfoAssist+ Format tab ribbon.
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Note: The HTML5 Chart Extensions page does not manage copyright or license restrictions.
You are ultimately responsible for the use of any HTML 5 Chart Extension you upload.

Therefore, you must ensure that you have a license or permission to use any HTML5 Chart

Extension before uploading it to this page.

Uploading Additional HTML5 Chart Extensions Using the Upload and Install Extensions Page

Use the Upload and Install Extensions page to install additional HTML5 Chart Extensions. To

open the Upload and Install Extensions page from the main HTML5 Chart Extensions page,

click Get more Extensions, as shown in the following image.

HTML5 Chart Extensions

Name:
Description:

Arc Chart
Arc Chart

The Upload and Install Extensio

ns page opens, as shown in the following image.

HTML5 Chart Extensions

Upload and Install Extension

| Choose File \ No file chosen

Extensions from GitHub. that are not installed

Name: Dimension counter by KPI t Install
Description: Dimension counter by KPL
Version: 11.2
APT Version: 2.0
Author: TIBCO Software
com.ibi.dimension_counter_by_kpi Copyright:  TIBCO Software Inc.
URL: hitps://github.com/ibi/wf-extensions-chart/tree/master/com.ibi.dimension_counter by kpi
License:
I & Name: bars horizontal 2 kpi + Install
-_g Description: bars horizontal 2 kpi
| g version: 223
- o APT Version: 2.0
_— 4 Author:  TIBCO Software
. = : - Copyright:  TIBCO Software Inc.
URL: hitps:/github.com/ibi/wf-extensions-chart/tree/master/horizontzsl comparison bars 2kpi
com.ibi.horizontal_2kpi License:
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Procedure:

The Upload and Install Extensions page provides two ways to install additional HTML5 Chart
Extensions:

. By clicking the Install Extension button in entries for chart extensions that are found
on the Information Builders public extension GitHub page, https://github.com/ibi/wf-
extensions-chart, but are not currently installed.

.4 By clicking the Choose File button [cheeseFie | next to Upload and Install Extension field to
navigate to a folder on your local file system that contains a locally-developed HTML5 Chart
Extension package in .zip file format.

To move back to the main HTML5 Chart Extensions page from the Upload an Install Extensions
page, click HTML Chart Extensions under the Application Settings Folder, or click the Back
button in your browser.

How to Upload HTMLS5 Chart Extensions from the Local File System

Use this procedure to upload zip files containing HTML5 Chart Extensions from your local
system.

You must ensure that you have a license or permission to use any HTML5 Chart Extension
before uploading it to this page.
1. Sign in as an administrator, and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

On the HTML5 Chart Extensions page, click Get more Extensions.

On the Upload and Install Extension page, click Choose File, as shown in the following
image.

HTML5 Chart Extensions

Upload and Install Extension

| Choose File \ No file chosen

Extensions from GitHub. that are not installed

The Open dialog box opens and points to the extensions folder for your local installation.
Typically, this is the following folder:

drive:\ibi\install_dir\config\web_resource\extensions
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where:
install_dir
Is your installation directory.

Note: If you downloaded your HTML5 Chart extension zip file to a different directory,
navigate to that directory and file.

Click the file containing the zipped version of the HTLM5 Chart extension you want to
upload, and then click Open.

When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll down
to the entry for the new HTML5 Chart Extension.

Procedure: How to Install HTML5 Chart Extensions From the IBI GitHub Page

Use this procedure to upload HTML5 Chart Extensions from the public IBI GitHub extension
page, https://github.com/ibi/wf-extensions-chart.

1.
2.

5.
6.

44

Sign in as an administrator, and open the Administration Console.

On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

On the HTML5 Chart Extensions page, click Get more Extensions.

On the Upload and Install Extension page, review the list of extensions from GitHub that
are not installed, as shown in the following image.

HTML5 Chart Extensions

Upload and Install Extension

\ Choose File \ No file chosen

Extensions from GitHub, that are not installed

Name: Dimension counter by KPT _g Install
Description: Dimension counter by KPL
Version: 112
APT Version: 2.0
Author: TIBCO Software
com.ibi.dimension_counter_by_kpi Copyright:  TIBCO Software Inc.
URL: ‘https://github.comyibi/wf-extensions-chart/tree/master/com.ibi.dimension_counter by_kpi
License:

If the chart extension you want to install appears in the list, click Install Extension .

When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the chart extension is now installed.
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Procedure: How to Enable an Installed HTML5 Chart Extension

When you select the Enable check box in an HTML5 Chart Extension entry, you make it
available for use. You must ensure that you have a license or permission to use any HTML5
Chart Extension before making it available.

1.
2.

Sign in as an administrator, and open the Administration Console.

On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension
that you want to enable.

Note: You can also search for the chart extension by name, using the Find or Find on this
page command that is supported by the browser.

Select the Enable check box, as shown in the following image.

Name: Chord Diagram (") Enable X

Description: Chord Diagram
-

AR Version: 18
AP Version: 1.0
Author: Three D Graphics
Copyright:  Three D Graphics Inc.
URL: https://github. com/ibi/wf-ext hart/tree/master/com.ibi.chord
License: BSD 3-clause

com.ibi.chord

When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the check box is now selected.

An icon for the HTML5 Chart Extension appears in the Select a Chart menu, which opens
when you click the Other command in the Chart Types group on the Format tab, and in the
Custom section of the Content Picker, which opens from the right side of the Designer
canvas.

Procedure: How to Disable an HTML5 Chart Extension

When you clear the Enabled check box in an HTML5 Chart Extension entry, you make it
unavailable for use. However, the chart extension remains installed on the HTML5 Chart
Extension page and can be enabled again when needed.

1.
2.

3.

Sign in as an administrator, and open the Administration Console.

On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension
that you want to make unavailable.

Note: You can also search for the chart extension by name, using the Find or Find on this
page command that is supported by the browser.
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4. Clear the Enabled check box, as shown in the following image.

Name: Chord Diagram Enabled | 3¢
Description: Chord Diagram
@l :

.\ Version: 1.6
API Version: 1.0
Author: Three D Graphics
Copyright: ~ Three D Graphics Inc.

com.ibi.chord Py y " . ,

URL: https://github. com/ibi/wf-extensions-chart/tree/master/ com.ibi.chord
License: BSD 3-clause

When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the check box is now cleared.

The icon for the HTML5 Chart Extension no longer appears in the Select a Chart Menu that
opens from the ribbon, or in the Custom section of the Content Picker, which opens from
the right side of the Designer canvas.

Procedure: How to Uninstall an HTML5 Chart Extension
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Sign in as an administrator, and open the Administration Console.

On the Configuration tab, under the Application Settings folder, click HTML5 Chart
Extensions.

On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension
that you want to uninstall.

Note: You can also search for the chart extension by name, using the Find or Find on this
page command that is supported by the browser.

Click Delete_CHARTNAME_ Chart, represented by the red X icon, as shown in the following
image.

Name: Chord Diagram Enabled
Description: Chord Diagram
-

'\ Version: 1.6
API Version: 1.0
Author: Three D Graphics
Copyright:  Three D Graphics Inc.

com.ibi.chord pyrig . o T

URL: https://github. com/ibi/wf-extensions-chart/tree/master/ com.ibi.chord
License:  BSD 3-clause

When you receive a message asking if you want to permanently delete the extension, click
Yes.

When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back
to your entry to confirm that the entry is now deleted.
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The entry for the HTML5 Chart Extension no longer appears on the page. If the HTML5
Chart Extension was installed from the GitHub page, it now appears on the Upload and
Install Extensions page and can be reinstalled from that page. If it was installed from your
local file system, it does not appear on that page, and you will be required to use the

Upload and Install Extension field and Browse button to reload the chart extension from
your local file system.
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Chapter
Db2 Web Query Change Management

Change management is the process of moving application components between Db2
Web Query environments of the same release level. Typically, this is done to ensure that
applications have been fully tested, prior to deploying to a production environment.

There are features and methodologies within Db2 Web Query that facilitate these
important tasks.

In this chapter:
4 Understanding the Change Management Process

.4 Creating a Change Management Package

Understanding the Change Management Process

Developing an application is an iterative process. Developers revise application code and
periodically move these components to the test environment for user feedback and

acceptance. At some point within the application development lifecycle, when the application is
stabilized, it is moved to production. After an application is released for general use, problems
must be fixed, tested, and incorporated into the production environment. This is the essence

of the change management process, which is also referred to as production control.

Organizations vary widely in how they approach change management. Some delegate much of

the responsibility to developers, while others establish alternative processes to maintain a
higher degree of control. Typically, developers utilize development tools to perform these
duties, while change management professionals prefer batch-oriented methods to move
application components between environments. Developers may be required to create a
change management package in order to initiate changes after the application is moved to
production. A combination of these approaches is often used in larger companies.

The examples that follow illustrate two different change management processes. These
sections describe product features and methodologies that can be utilized by companies to
meet their change management objectives.

Administering Db2 Web Query for i
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Moving Application Files: A Simple Change Management Process

Developers move application files between the development and test environments using their
development tool, as shown in the following image. When the application is finished, the
application is copied from the test environment to the production environment, using operating
system utilities. There may only be a single test environment.

Development Production
Developer
copy/paste CM = Change Management

{using tool)

Moving Application Files: A Comprehensive Change Management Process

In this example, four environments are established to increase the level of control of moving
application code to production. Developers use the Resources tree to move application files
from the development environment to the test environment. Developers then use the Change
Management Export facility when they are ready to move their changes to the user acceptance

test environment.
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The Change Management Export facility allows the developer to select the resources to be
moved and creates a change management package. An administrator can subsequently move
the change management package into an acceptance test using the Change Management
Import facility. Some organizations may choose to utilize an automated process to import the
content, to achieve better integration with their business processes. As shown in the following
image, when the application is deemed ready for release, the production control personnel
initiate a file system copy of the application to the production environment. Users begin using
the application and the change management process shifts into an application maintenance
support role. From this point forward, incremental updates to production are facilitated by
administrators using the Change Management Import facility.

Development Production

Developer
copy/paste
(using tool)

= CM loads package
Developer creates 3
change package

CM transfer CM = Change Management

Creating a Change Management Package

Procedure:

Many organizations do not grant developers write access to the user acceptance test and
production environments. Access to these environments is strictly controlled and granted only
to administrators, production control personnel, or automated change management processes.

Only developers know which changes are ready to be moved into the test environment. The
Change Management Export facility presents developers with a graphical view of the resources
they manage and allows them to build a change management package. This package is then
loaded into another environment by production control personnel or automated processes.

How to Create a Change Management Extract Package

A user must be a Web Query developer or administrator to create a Change Management
Export Package.

The steps required for creating a Change Management Package are:

1. Create a Scenario. Using the Change Management Export user interface, create a Change
Management scenario by selecting the resources to be exported. A scenario is a
description of all the resources included in a Change Management Export Package.
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2. Export a Scenario. After creating a scenario, export it to the change management export
directory as a change management package. The export process produces the package in
two formats: a folder and a Change Management zip file. The folder contains the expanded
contents of the change management package. The Change Management zip file contains
the compressed contents of that package in a format that is ready to download and
transfer to target environments. This Change Management Export Package is placed in the
directory with the same name as the scenario:

/ qi bm user dat a/ qwebqry/ base80/ cm export

The exported folder is then copied to the target environment and placed in the following
directory:

/ gi bm user dat a/ qwebqr y/ base80/ cm i nport

Note: The Change Management Export and Import activity is written to the following log
file:
/ qi bm user dat a/ gqwebqry/ base80/ | ogs/ i npex. | og

3. Download a Scenario. For convenience, the change management zip file can be
downloaded, using a web browser, from the export directory to a location outside of the
change management directory. From this external location, the change management zip

file is available for transfer to the import directory of the target Db2 Web Query
environment, where its content can be imported and accessed.

Procedure: How to Access the Change Management Export Facility to Create a Scenario

1. On the Hub side navigation pane, select Management Center and Export Packages.
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Or, on the Web Query Home page, in the banner, open the Utilities menu, and select
Change Management and Export to open the Scenarios dialog box, as shown in the
following image.

0

Title 1 Last Modified

test 12/23/2022 7:48:07 AM
wq_demo 12/23/2022 7:54:07 AM
wgadmin.zip 12/23/2022 7:57:30 AM

New sce“ario

2. Select New Scenario to open the New Scenario dialog box, as shown in the following
image.

New Scenario X

Name: |

3. Inthe New Scenario dialog box, type a name for the scenario, and then select Create to
open the Change Management Export Interface, as shown in the following image.

o W 4 @ Bport

B With Rules B Retain Handles
» @ Repository Title Full Path With Private Content With Subtree ]
» (3 Reporting Servers

This will invoke the user interface to create the Scenario, which allows a user to select
Resources that will be moved to the target system.

There are two major options listed on the top of the Change Management Export Interface.
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With Rules. Unselected by default. This option should not be selected.

Retain Handles. This option is necessary when a release 2.1.x or 2.2.x source
environment is migrated from a 1.1.x release of Db2 Web Query, and this content is used
in a Change Management process. During migration from release 1.1.x to release 2.1.x or
2.2.x, the 1.1.x release hrefs are used as the 2.1.x or 2.2.x release handles to allow the
earlier code for -INCLUDEs and drill downs to continue to work with the release 1.1.x style
syntax. Moving these handles to the target environment, will allow code that contained the
earlier style -INCLUDE and drill down syntax to continue to work.

The following types of resources can be moved:

.4 Any folder or item from the /WFC/Repository or what is shown in the user interface as
Db2 Web Query, including procedures (FOCEXECs), Stylesheets, Images, HTML files,
Schedules, and Distribution Lists.

- Any application or specific files from the Reporting Server node on the tree.

Selecting Resources

.d Resources are selected by either dragging content from the Change Management tree
on the left, to the right pane. Or, using the context menu and right-selecting the
content you want to move, and choosing either Select With Sub-tree or Select Folder
Only.

4 Select With Sub-tree selects that folder and all subfolders.

. Select Folder Only selects the specific folder, with no content. Typically, that is
done to move rules on the folder.

When your selection is complete, an entry for it appears in the right pane, and a
strikethrough line appears on the entry under the Resources tree.

d If you select a private resource, the With Private Content check box is automatically
selected and cannot be cleared.

d If you select private content, it will only be imported if the owner of that private content
already exists in the target environment.

d If you select a published folder, you can include private content within it by selecting
the With Private Content check box for that resource. This selection exports all of the
private content in that folder and its subfolders, including those My Content folders
that are assigned to individual users, even if you do not have the privileges necessary
to view that private content.
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I If you select a subfolder without a parent folder, the Import process will recreate the
parent folder in the target environment. A connection to the same metadata must exist
within the target environment as well as the source environment.

IJ When selecting a collaborative portal and pages that reference external content, be
sure to include that content in the change management package.

I If the rules on the source and target environments are different, users may have
access to private content in the source environment, but be denied access in the
target environment. This occurs if users have access to the published folder that
contains the private content in the source environment, but do not have it in the target
environment.

Selecting a folder

= & # & Boport
B With Rules [ Retain Handles
- a Repository Title
> uMYWOIkSpBOE

r B 43 Refresh

»
b
>

w W W Export
® With Rules B Retain Handles

+ @ Repository Title [Full path | with Private Content |with subtree
My Workspace IBFS:/WFC/Repository/My_Workspace a

» |4l My Content

4. Now that resources are selected, the Scenario should be saved.

Once saved, the Scenario can be run through the Change Management Import interface.

Procedure: How to Download a Change Management Package Zip File

The export process saves a change management zip file to /gibm/userdata/qwebqry/
base80/cm/export. The download process takes that change management zip file, and
downloads it to your local machine. You can then transfer the copy of that change
management zip file to another Web Query environment for use as a change management
package.

1. On the Hub side navigation pane, select Management Center and Export Packages.
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Or, on the Web Query Home Page, in the banner, open the Utilities menu, and select
Change Management and Export to open the Scenarios dialog box, as shown in the
following image.

0

Title 1 Last Modified

test 12/23/2022 7:48:07 AM
wq_demo 12/23/2022 7:54:07 AM
wgadmin.zip 12/23/2022 7:57:30 AM

New Sce"ario

2. Rightclick the change management zip file you want to download, and then click
Download, as shown in the following image.

Scenarios E = @

Title 1 | Last Modified

test 12/23/2022 7:48:07 AM
wq_demo 12/23/2022 7:54:07 AM
wgadmin.zip 12/23/2022 7:57:30 AM

X Delete DEL

Download S

New Scenario
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Note: When choosing between two list entries that include the same name, you can
distinguish the full change management package from the zip file version by remembering
that the name assigned to the Zip file includes the name of the change management
package from which it was taken, the date and time on which the package was created,
and the ID of the user who created it. The name assigned to the full change management
package does not contain any of these additional details.

Save the change management zip file to an external location as directed by your browser.

Close the Scenarios dialog box.

Procedure: How to Upload a Change Management Package Zip File

The zip file upload process saves a copy of a change management zip file stored on your local
machine to the change management import directory on the server, /qibm/userdata/qwebqry/
base80/cm/export. You can then import the copy of that change management zip file to Web

Query.

1. On the Hub navigation pane, select Management Center and Import Packages.

Or, on the Web Query Home Page, in the banner, open the Utilities menu, and select
Change Management and Import to open the Import Packages dialog box, as shown in the
following image.

Import Packages ‘:E ‘E|

Title T Last Modified
DB2_Web_Query_demo 12/28/2015 4:42:46 PM
OLAP-12_IBM_Case_Repro 1/77/2016 5:25:56 PM
Retail_samp_20221122_051601_wqadmin.zip 12/14/2022 11:41:55 AM
Retail_Samples 10/31/2017 4:09:48 PM
Retail_Samples_240_1039942758850443930 12/14/2022 7:11:12 AM
Retail_Samples_240.zip 12/14/2022 7:10:56 AM
RS_20221214_071453_wqadmin4.zip iimpork k 12/14/2022 7:13:23 AM
Tonys_Demo X Delete DEL 3/14/2017 10:16:08 AM
wqrax_webservices 11/2/2016 9:29:42 AM
Upload a zip file ‘ Refresh ‘

2. Select the change management zip file you want to upload, and then click Upload a zip
File.
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The Upload a zip File dialog box opens, as shown in the following image.

Upload a zip file X

Publish documents(s)
|

3. Click Browse, navigate to the location where you have saved the change management
package, click the change management zip file you want to upload, and then click Open.

4. Ensure that the correct change management zip file appears in the File to Upload field,
and decide whether or not to import files from the package as published or unpublished
files.

.4 To establish the contents taken from the change management zip file as published
after the upload is complete, select the Publish Documents check box. This is the
default setting.

.d To establish the contents taken from the change management zip file as private after
the upload is complete, clear the Publish Documents check box.

5. Click Upload.
A confirmation dialog box opens. Click OK to complete the upload.
6. Inthe Upload a Zip File dialog box, click Close.

If an entry for the new change management zip file does not appear below the Import
node, right-click it, and then click Refresh.

Procedure: How to Import a Change Management Package
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A user must be a Web Query administrator to Import a Change Management Package.

This step assumes that a Change Management Extract Package has been previously created
and has been copied to the target environment in the following directory:

/ qi bm user dat a/ qwebqry/ base80/ cni i nport

1. On the Hub side navigation pane, select Management Center and Import Packages.
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Or, on the Web Query Home Page, in the banner, open the Utilities menu, and select
Change Management and Import to open the Import Packages dialog box, as shown in the
following image.

Import Packages E H @

Title 1 | Last Modified
DB2_Web_Query_demo 12/28/2015 4:42:46 PM
OLAP-12_IBM_Case_Repro 1/7/2016 5:25:56 PM
Retail_samp_20221122_051601_wgadmin.zip 12/14/2022 11:41:55 AM
Retail_Samples 10/31/2017 4:09:48 PM
Retail_Samples_240_1039942758850443930 12/14/2022 711:12 AM
Retail_Samples_240.zip 12/14/2022 7:10:56 AM
RS_20221214_071453_wgadmind.zip 12/14/2022 7:13:23 AM
Tonys_Demo 3/14/2017 10:16:08 AM
wqrax_webservices 11/2/2016 9:29:42 AM

Upload a zip file

2. Rightclick the change management Zip file you want to import, and then click Import to
open the Import Package dialog box, as shown in the following image.

Import Package: Retail_Samples_240.zip X

Content Resources

@ Add New Resources Only (do not replace)
(O Add New and Update Existing Resources

Portal Resources

New portals and new pages in existing portals will be created.

Security Resources

Add New Add/Replace
Roles
Groups

Users

oooo

Import Rules On Resources

=
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In the Content Resources group, accept the default selection, Add New Resource Only (do
not replace), to limit the change management import to new content resources.

or

Select Add New and Update Existing Resources, to enable the change management import
to include updates to existing content resources as well as new content resources.

In the Security Resources group:

a. Select the Roles check box to include Roles in the Change Management Import
package.

b. Select the Groups check box to include groups in the Change Management Import
package.

c. Select the Users check box to include the individual users in the Change Management
Import package.

For each security resource, accept the default selection, Add New, to limit the Change
Management Import to new security resources.

or

Click Add/Replace, to enable the Change Management Import to include updates to
existing security resources as well as new security resources.

d. Select the Import Rules on Resources check box to include any new rules assigned to
the security resources included in the Change Management Import package.

When the configuration is complete, click Import.

The import process loads content from the change management package into the folders
that match the name and spelling of the corresponding folders in the old environment. If
the resources in the change management package are assigned to the same folders and
locations as in the existing environment, there are no visible changes.

However, if you do not see your expected changes, right-click the Workspaces entry in the
Resources tree and select Refresh.
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SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT
IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software
Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, FOCUS, iWay, Omni-Gen, Omni-HealthData, and
WebFOCUS are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation and/or its affiliates.

All other product and company names and marks mentioned in this document are the property
of their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the
readme file for the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S)
DESCRIBED IN THIS DOCUMENT AT ANY TIME.
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THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2022. TIBCO Software Inc. All Rights Reserved.
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